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v

About this document 0

This guide includes planning and installation information on the Site Manager 
software. Site Manager is a nodal management tool that you can use to operate, 
administer, maintain, and provision network elements.

This planning and installation guide includes the following topics:

• Supported products and features

• Site Manager installation

• Site Manager overview

• Ordering information

Note 1:  For specific information on how to use Site Manager for a 
particular product, refer to the documentation for that product. Nortel 
Networks technical publications (NTPs) are available online and in print 
form.

Note 2:  For information on Site Manager online help, see Online help on 
page 3-11.

Audience
The following members of your company are the intended audience of this 
guide:

• planners

• provisioners

• network administrators

xxx-yyyy-zzz
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References
This document refers to the following guides and NTPs:

• Preside Applications Platform Interface Login User Guide, 450-3101-012

• Preside Applications Platform Installation and Administration User 
Guide, 450-3101-201

• Preside Applications Platform Planning Guide, 450-3101-601

• Nortel Networks OPTera Metro 3300/3400 Multiservice Platform 
Release 11.1 Planning and Ordering Guide, NTRN11AL

• Nortel Networks OPTera Metro 3300/3400 Multiservice Platform Security 
and Administration, 323-1051-302

• Nortel Networks OPTera Metro 3300/3400 Multiservice Platform 
Installation, 323-1051-201

• Nortel Networks OPTera Metro 3500 Multiservice Platform Release 12 
Planning and Ordering Guide, NTRN10AM

• Nortel Networks OPTera Metro 3500 Multiservice Platform Security and 
Administration, 323-1059-302

• Nortel Networks OPTera Metro 3500 Multiservice Platform Installation, 
323-1059-201

• Nortel Networks OC-48 Lite Multiplexer Planning Guide, NTLS63AB

• Nortel Networks OC-48 Lite Multiplexer Preside Site Manager User 
Guide, NTLS65BB

• Nortel Networks OC-48 Lite Multiplexer Preside Site Manager Alarm 
Clearing Guide, NTLS65CB

• Nortel Networks OC-48 Lite Multiplexer Installation and Site Testing 
Procedures, 323-1231-201

Text conventions
The following table lists the text conventions used in this document.

Item Convention Example

Hardkey combinations The plus sign (+) is used to indicate that you must 
press two keys at the same time.

Press Shift+:

Return key The return key symbol (↵) is used to indicate that 
you must press the return key. 

cd /tmp ↵

User input Angle brackets are used to indicate variable input. Enter <hostname > 
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Technical support and information
For technical support and information from Nortel Networks, refer to the 
following table.

Technical Assistance Service

For service-affecting problems:
For 24-hour emergency recovery or software upgrade 
support, that is, for:

• restoration of service for equipment that has been carrying 
traffic and is out of service

• issues that prevent traffic protection switching

• issues that prevent completion of software upgrades

North America: 
1-800-4NORTEL (1-800-466-7835)

International: 
001-919-992-8300

For non-service-affecting problems:
For 24-hour support on issues requiring immediate support 
or for 14-hour support (8 a.m. to 10 p.m. EST) on 
non-urgent issues.

North America:
1-800-4NORTEL (1-800-466-7835)

Note:  You require an express routing 
code (ERC). To determine the ERC, see 
our corporate Web site at 
www.nortelnetworks.com. Click on the 
Express Routing Codes link.

International: 
Varies according to country. For a list of 
telephone numbers, see our corporate 
Web site at www.nortelnetworks.com. 
Click on the Contact Us link.

Global software upgrade support:
For non-service affecting software upgrade issues

North America:
1-800-4NORTEL (1-800-466-7835)

International: 
Varies according to country. For a list of 
telephone numbers, see our corporate 
Web site at www.nortelnetworks.com. 
Click on the Contact Us link.
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1-1

Supported products and features 1-

This chapter lists the products and associated features supported by Site 
Manager Release 6.0.

Supported products
Table 1-1 lists the products supported by Site Manager Release 6.0.

Note:  If Site Manager does not support the product release or if the shelf 
processor is not running the same load as the rest of the network element, 
only the following applications will be available: Active Alarms, Events, 
Backup and Restore, Upgrade Management, and Load Installation 
Management.

Table 1-1
Supported products

Product Release

Nortel Networks OPTera Metro 3100 Multiservice Platform 4.0

Nortel Networks OPTera Metro 3300/3400 Multiservice Platform 9.1 and 11.1

Nortel Networks OPTera Metro 3500 Multiservice Platform 10.1,10.3, 11.0, 
and 12.0

Nortel Networks TransportNode OC-48 Lite Multiplexer 1.0 and 1.1

xxx-yyyy-zzz
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Features for supported products
Table 1-2 summarizes the Site Manager features for the OPTera Metro 3100, 
3300, 3400, and 3500 products, and the OC-48 Lite Multiplexer product.

Table 1-2
Summary of Site Manager features for supported products

Feature OPTera Metro 3000 series OC-48 Lite 
Multiplexer

3100 3300/3400 3500

Rel. 4.0 Rel. 9.1 Rel. 11.1 Rel. 10.1 
and 10.3

Rel. 11.0 Rel. 12.0 Rel. 1.0 
and 1.1

Alarms

• Active alarms √ √ √ √ √ √ √

• Alarm cut-off √ √ √ √ √ √ √

• Alarm flow control n/a n/a √ n/a √ √ n/a

• Alarm profiles n/a √ √ √ √ √ n/a

• Alarm provisioning 
including external alarms

√ √ √ √ √ √ √

• Event reporting √ √ √ √ √ √ √

• External controls √ √ √ √ √ √ √

• Span of control alarm list √ √ √ √ √ √ n/a

Backup and restore √ √ √ √ √ √ √

Bay command console 
(BCC) command line 
interface (CLI)

n/a n/a n/a √ √ √ n/a

Bidirectional line-switched 
ring (BLSR) management

n/a n/a n/a √ √ √ n/a

• Full VT management n/a n/a n/a n/a √ √ n/a

• STS management n/a n/a n/a √ √ √ n/a

Connection identification n/a √ √ √ √ √ n/a

Connection management

• End-to-end connections √ √ √ √ √ √ n/a

• Nodal connections √ √ √ √ √ √ (Read only)

• Virtual concatenation n/a n/a n/a n/a n/a √ n/a

• VT BLSR n/a n/a n/a n/a √ √ n/a
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Equipment and facility 
provisioning

√ √ √ √ √ √ √

General broadcast 
messaging between users 
logged in to an NP or SP

n/a n/a n/a n/a n/a √ n/a

Inventory list √ √ √ √ √ √ √

In-service traffic 
rollover (ISTR)

√ √ √ √ √ √ √

Login management (direct, 
remote, or Ethernet 
access)

√ √ √ √ √ √ √

Map topology √ √ √ √ √ √ n/a

• Displaying adjacent 
network elements 
outside the span of 
control

n/a n/a √ n/a √ √ n/a

Management Information 
Base (MIB) browser

n/a n/a n/a √ √ √ n/a

Modifiable login banner n/a n/a n/a n/a n/a √ n/a

Multiple network elements 
(NE) access

√ √ √ √ √ √ √

Multiple window 
environment

√ √ √ √ √ √ √

Node information √ √ √ √ √ √ √

• Common Language 
Location Identifier (CLLI) 
provisioning

n/a n/a √ n/a √ √ n/a

Online help

• Context-sensitive help 
for windows, dialog 
boxes, and menus

√ √ √ √ √ √ √

• Procedural information n/a √ √ √ √ √ √

Table 1-2 (continued)
Summary of Site Manager features for supported products

Feature OPTera Metro 3000 series OC-48 Lite 
Multiplexer

3100 3300/3400 3500

Rel. 4.0 Rel. 9.1 Rel. 11.1 Rel. 10.1 
and 10.3

Rel. 11.0 Rel. 12.0 Rel. 1.0 
and 1.1
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OPTera Packet Edge 
(OPE)

n/a n/a

• Alarms

— Active alarms √ √ √ √ √

— Trap activation and 
provisioning

√ √ √ √ √

• Ethernet network to 
network interface (NNI) 
redundancy

n/a n/a n/a √ √

• Management Information 
Base (MIB) Browser

√ √ √ √ √

• Network topology √ √ √ √ √

• Overbooking (fairness) n/a √ n/a √ √

• SNMP settings √ √ √ √ √

• Traffic management

— Static routing √ √ √ √ √

— WAN load sharing √ √ √ √ √

Optical Ethernet-Private 
Line (OE-PL) service 
provisioning

n/a n/a √ n/a √ √ n/a

Performance monitoring 
(PM) (counts and 
thresholds)

√ √ √ √ √ √ √

• Physical PM counts n/a n/a n/a n/a √ √ n/a

• Protection PM counts n/a n/a √ n/a √ √ n/a

• Threshold crossing 
report type

n/a n/a n/a n/a n/a √ n/a

Protection provisioning 
and status

√ √ √ √ √ √ √

Protection exerciser n/a √ √ √ √ √ √

Table 1-2 (continued)
Summary of Site Manager features for supported products

Feature OPTera Metro 3000 series OC-48 Lite 
Multiplexer

3100 3300/3400 3500

Rel. 4.0 Rel. 9.1 Rel. 11.1 Rel. 10.1 
and 10.3

Rel. 11.0 Rel. 12.0 Rel. 1.0 
and 1.1
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Security and 
Administration

• Customer managed 
network (CMN)

n/a √ √ √ √ √ n/a

• Intrusion attempt 
handling

n/a √ √ √ √ √ n/a

• Invalid password n/a √ √ √ √ √ n/a

• Password change √ √ √ √ √ √ √

• Security logs n/a √ √ √ √ √ n/a

• User authentication

— Local account (user ID 
and password)

√ √ √ √ √ √ √

— Local challenge-
response

n/a n/a √ n/a √ √ n/a

— Remote access dial-in 
user authentication 
service (RADIUS)

n/a n/a √ n/a √ √ n/a

• User profile √ √ √ √ √ √ √

Shelf level view √ √ √ √ √ √ √

Software upgrade and load 
installation management

√ √ √ √ √ √ √

Span of control √ √ √ √ √ √ √

Synchronization 
provisioning

• Time of day (TOD) n/a n/a √ n/a √ √ n/a

• Timing mode √ √ √ √ √ √ √

• Timing reference √ √ √ √ √ √ n/a

Target identifier address 
resolution protocol (TARP) 
provisioning

√ √ √ √ √ √ √

Table 1-2 (continued)
Summary of Site Manager features for supported products

Feature OPTera Metro 3000 series OC-48 Lite 
Multiplexer

3100 3300/3400 3500

Rel. 4.0 Rel. 9.1 Rel. 11.1 Rel. 10.1 
and 10.3

Rel. 11.0 Rel. 12.0 Rel. 1.0 
and 1.1
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Telemetry byte-oriented 
serial protocol (TBOS) 
provisioning

√ √ √ √ √ √ n/a

Test access

• Creating or editing a test 
access session

n/a n/a n/a n/a n/a √ n/a

• Retrieving test access 
information

n/a n/a n/a n/a n/a √ n/a

• Time out period 
provisioning

n/a n/a n/a n/a √ √ n/a

• Test access port 
provisioning and 
releasing

n/a n/a n/a n/a √ √ n/a

TL1 command builder √ √ √ √ √ √ n/a

TL1 event logging n/a n/a √ n/a √ √ n/a

Trap proxy n/a √ √ √ √ √ n/a

Table 1-2 (continued)
Summary of Site Manager features for supported products

Feature OPTera Metro 3000 series OC-48 Lite 
Multiplexer

3100 3300/3400 3500

Rel. 4.0 Rel. 9.1 Rel. 11.1 Rel. 10.1 
and 10.3

Rel. 11.0 Rel. 12.0 Rel. 1.0 
and 1.1
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2-1

Site Manager installation 2-

This chapter describes how to install Site Manager. You can install Site 
Manager on a:

• personal computer (PC)

• HP-UX 11 workstation 

Note:  You can install Site Manager co-resident with Preside Applications 
Platform (AP) Release 9.1 or higher on an HP-UX 11 workstation

• Sun workstation

Application kit contents
The application kit contains the following items:

• CD-ROM with the Site Manager software

• electronic version of the Site Manager Planning and Installation Guide 
(this guide)

xxx-yyyy-zzz
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Installation requirements
Operating platforms

Table 2-1 lists each supported operating platform and the corresponding 
supported operating systems.

HP-UX 11 patches
For HP-UX 11 installations, you must install the software patches included on 
the HP-UX 11 OS Patches Bundle Supplement for Preside host platforms 
CD-ROM, April 2002 version or later. For ordering information, see Preside 
Applications Platform Planning Guide, 450-3101-601, Release 9.1 or higher. 
For installation procedures, see Preside Applications Platform Installation and 
Administration User Guide, 450-3101-201, Release 9.1 or higher.

HP-UX 11 kernel parameters
The following table includes the required kernel parameters that you must 
change on the workstation running HP-UX 11:

Table 2-1
Operating platforms

Operating platform Supported operating systems

Personal computer 
(PC)

• Windows 98

• Windows 2000

• Windows NT workstation version 4

• Windows XP

Hewlett Packard (HP) 
workstation

• HP-UX 11 (see Note)

Sun workstation • Solaris 8

Note:  For information about the required patches and kernel parameters, see 
HP-UX 11 patches on page 2-2 and HP-UX 11 kernel parameters on page 2-2.

Table 2-2
Kernel parameters

Kernel parameter Value

dbc_max_pct 50

dbc_min_pct 5

max_thread_proc 1200

maxdsiz 2063835136

maxdsiz_64 2063835136

maxfiles 2048
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For more information about the HP-UX 11 kernel parameters, visit the Hewlett 
Packard website at:
http://h21007.www2.hp.com/dspp/tech/tech_TechDocumentDetailPage_IDX
/1,1701,1608,00.html

maxfiles_lim 2048

maxssiz 0x04000000

maxsiz_64 0x04000000

maxswapchunks 4096

maxuprc 512

maxusers 512

msgtql 1024

ncallout nkthread + 16

nfile 5128

ninode 3048

nkthread (nproc*2)+(1000)

nproc 2088

npty 200

semmni 128

semmns 512

semmnu 512

shmmax 1073741824

shmseg 120

vps_ceiling 16

vps_pagesize 4

Note:  If the Preside Applications Platform Planning Guide 
recommends a kernel parameter value that is different than 
the value recommended in this table, use the greater of the 
two values.

Table 2-2
Kernel parameters

Kernel parameter Value
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Site Manager configurations with Preside AP

Preside AP workstations must meet the minimum requirements to support 
Preside AP Release 9.1 or higher. For more information on supported 
Preside AP workstations, see the Preside Applications Platform Planning 
Guide, 450-3101-601.

Hardware requirements
Table 2-3 identifies the minimum and recommended hardware requirements 
for Site Manager.

ATTENTION
Preside AP Release 9.1 and higher run on HP-UX 11. Starting with Preside 
AP Release 9.1, Site Manager can be installed co-resident with Preside AP.

Table 2-3
Site Manager hardware requirements

PC HP workstation 
(see Note)

Sun workstation
(see Note)

Minimum hardware requirements

CD-ROM drive or 
network access

Required Same as the supported 
platform in Preside AP 
requirements

(See hardware 
requirements for 
supported hardware 
platforms in Preside 
Applications Platform 
Planning Guide, 
Release 9.1 or higher)

Required

Hard disk space 100 Mbyte 500 Mbyte

Monitor 256-color display 256-color display

Processor Pentium processor at 
233 MHz

UltraSparc IIi 300 MHz 
(Ultra 10 Model 300 or 
better)

RAM 64 Mbyte 256 Mbyte

Recommended hardware requirements

CD-ROM drive or 
network access

Required Same as the supported 
platform in Preside AP 
requirements

(See hardware 
requirements for 
recommended hardware 
platforms in Preside 
Applications Platform 
Planning Guide, 
Release 9.1 or higher)

Required

Hard disk space 200 Mbyte 500 Mbyte

Monitor 256-color display or 
better

256-color display or 
better

Processor Pentium processor at 
400 MHz or higher

UltraSparc IIe 500 MHz 
(SunBlade 100 or better)

RAM 128 Mbyte or higher 512 Mbyte

Note:  Use the default software parameters with respect to the guided installation option of the 
operating system software.
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Other hardware requirements
For details on other hardware requirements specific to the supported products, 
refer to:

• OPTera Metro 3000 series: Refer to the Planning and Ordering Guide for 
the OPTera Metro 3000 release you are running. Refer to Documentation 
on page 4-2 for product engineering codes (PEC) for OPTera Metro 3000 
documentation.

• OC-48 Lite Multiplexer: Nortel Networks OC-48 Lite Multiplexer 
Planning Guide, NTLS63AB

Additional hardware
You can use one of the following modems:

• Hayes compatible modem at 2400 baud (minimum)

• Hayes compatible modem at 19200 baud (recommended)

Equipment connection
Table 2-4 identifies the Nortel Networks technical publications (NTPs) to 
consult for equipment connection details.

Table 2-4
NTPs that include equipment connection information

Product NTP title NTP number

OC-48 Lite Multiplexer Installation and Site Testing 
Procedures

323-1231-201

OPTera Metro 3300/3400 Installation 323-1051-201

OPTera Metro 3500 Installation 323-1059-201
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Engineering rules

• Maximum number of Site Manager sessions supported on a PC with 
minimum or recommended hardware requirements: 1

• Maximum number of Site Manager sessions supported on an HP-UX 11 or 
Sun workstation with minimum or recommended hardware requirements: 
No software-imposed restriction (see Note)

Note:  When Site Manager is not installed co-resident with Preside AP, the 
number of sessions is limited by hardware resources only. 

• Maximum number of network elements supported in one Site Manager 
session: one full span of control, including the controller (if applicable)

• Maximum number of OPTera Packet Edge nodes supported in one Site 
Manager session: 32

Preside AP/MOA co-residency
It will be possible for Site Manager, Preside AP, and the Managed Object 
Agent (MOA) to coreside on the same workstation when HP-UX 11 is a 
supported operating platform for the Preside AP and MOA workstation.

ATTENTION
The number of sessions specified in this section varies depending on the 
memory required by the other processes running on the PC or workstation 
and the allocated swap space.

If you do not follow the engineering rules, you will impact the 
performance of all Site Manager sessions running on a PC or workstation. 
Unexpected behavior can occur if the number of sessions is exceeded.

Table 2-5
Preside AP/MOA co-residency

Description Number of sessions

Number of Site Manager sessions that you can launch 
simultaneously on a workstation where Site Manager, 
Preside AP and MOA are co-resident (see Note)

limited to 10

Note:  The workstation must meet the minimum hardware requirements as 
described in the Preside Applications Platform Planning Guide for the release you 
installed on the workstation. In addition, the workstation must have a minimum of 
1-Gbyte RAM and 2-Gbyte swap space.
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Access methods
Site Manager allows you to access a network element by the following 
methods:

• direct cable (RS-232)

• modem

• Ethernet

Installing Site Manager
Table 2-6 lists the procedures you need to follow to install Site Manager for 
your required configuration.

Table 2-6
Procedures for installing Site Manager based on configuration

Configuration Procedure(s) to complete

Site Manager on a PC Installing Site Manager on a PC on page 
2-8

Site Manager on an HP-UX 11 
workstation

(see Note)

Installing Site Manager software files on 
an HP-UX 11 workstation on page 2-9

Site Manager on a Sun workstation Installing Site Manager software files on 
a Sun Solaris 8 workstation on page 2-11

Site Manager on an internal web server Installing Site Manager on an internal 
web server for web distribution on page 
2-13

Note:  You can install Site Manager co-resident with Preside Applications Platform 
(AP) Release 9.1 or higher.
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Procedure 2-1
Installing Site Manager on a PC

Use this procedure to install Site Manager on a personal computer (PC).

Requirements
Before you start the software installation, you must:

• uninstall Site Manager if it is already installed on your PC. See 
Procedure 2-6, Uninstalling Site Manager from a PC

• ensure that your system meets the installation requirements. See 
Installation requirements on page 2-2

• close all applications before installing Site Manager

Step Action

1 Insert the Site Manager CD-ROM in the CD-ROM drive. 

2 If the Site Manager Introduction screen is displayed automatically, go to 
step 6.

3 From the Windows taskbar, click Start and then select Run.

4 In the Open field of the Run dialog box, enter the following command:

e:\install.exe ↵

5 Click OK.

6 In the Preside Site Manager Introduction screen, click Next, then follow the 
instructions on the screen to progress through the installation sequence. 
During the installation, you are prompted to

a. accept the license agreement

b. select the folder where you want to install the software

c. create a shortcut for accessing Site Manager

Note:  Do not use any of the following characters when specifying the 
installation folder or the shortcut location: < , > , / , \ , ? , * , : , |.
Using any of these characters prevents Site Manager from installing correctly 
(although no error message is displayed). If this occurs, you must re-install 
Site Manager.

7 In the Preside Site Manager Install Complete screen, click Done to 
acknowledge completion of the installation.

Note:  You do not need to install any other software. The Java virtual machine 
is included with the installation of the Site Manager software.

—end—

where

e is your CD-ROM drive letter
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Procedure 2-2
Installing Site Manager software files on an HP-UX 11 workstation

Use this procedure to install Site Manager on an HP-UX 11 workstation.

Requirements

Before you start this procedure you must:

• close all applications before installing Site Manager

• ensure that the HP-UX 11 software is installed on the workstation

Note:  To confirm that you have the correct version of the HP-UX 11 
software installed on the workstation, use the uname -r command. The 
expected result is B.11.11. 

• be authorized to log in to the workstation as the UNIX root user

• ensure you know the CD-ROM device name. If you do not know the name, 
see Procedure 2-5, Recording the CD-ROM device name.

Hardware
The minimum and recommended hardware requirements for an HP-UX 11 
workstation on which Site Manager Release 6.0 is installed are the same as for 
the Preside AP Release 9.1 workstation. For more information on the 
minimum and recommended hardware platforms, see the section on hardware 
requirements in Preside Applications Platform Planning Guide, 
450-3101-601, Release 9.1 or higher.

Step Action

1 Insert the Site Manager CD-ROM in the CD-ROM drive.

2 Log in to the HP-UX 11 workstation as the root user by entering the root 
userID and the password in the login dialog box.

3 Open a console window.

4 Change to the /tmp directory by entering

cd /tmp  ↵

Note:  You can start the software installation process from any directory. 
However, use the /tmp directory to ensure the installation files are stored in 
one location.

—continued—

ATTENTION
Do not uninstall Site Manager if it is already installed on your HP-UX 11 
workstation.
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Procedure 2-2 (continued)
Installing Site Manager software files on an HP-UX 11 workstation

Step Action

5 Create a new directory to store the CD-ROM files by entering

mkdir /cdrom ↵

6 Mount the CD-ROM in the directory created by entering

mount /dev/dsk/<device name> /cdrom ↵
where the device name is the name of the CD-ROM drive, for example, 
c1t2d0.

7 Retrieve the installation files from the /cdrom directory by entering

cp /cdrom/HPUX/install.bin ./install.bin ↵
8 Start the software installation process by entering

sh ./install.bin ↵

9 Click Next to progress through the installation sequence. 

During the installation, you are prompted to

a. accept the license agreement

b. select the folder where you want to install the software (the default folder 
location is /opt/nortel/applications/sitemanager)

10 Click Done to acknowledge completion of the installation.

11 The CD-ROM drive must be unmounted from the workstation. Unmount the 
CD-ROM drive by entering

umount /cdrom ↵
Note:  For information on running Site Manager, see the Preside Applications 
Platform Interface Login User Guide, 450-3101-012.

—end—
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Procedure 2-3
Installing Site Manager software files on a Sun Solaris 8 workstation

Use this procedure to install Site Manager on a Sun Solaris 8 workstation.

Requirements

Before you start this procedure you must:

• close all applications before installing Site Manager

• ensure that the Solaris 8 software is installed on the workstation

• be authorized to log in to the workstation as the UNIX root user

• have the Site Manager installation CD-ROM

Hardware
For more information on the minimum and recommended hardware 
requirements, see Hardware requirements on page 2-4.

Step Action

1 Insert the Site Manager CD-ROM in the CD-ROM drive.

2 Log in to the workstation as the root user by entering the root userID and the 
password in the login dialog box.

3 Open a console window.

4 Change to the /tmp directory by entering

cd /tmp  ↵
Note:  You can start the software installation process from any directory. 
However, use the /tmp directory to ensure the installation files are stored in 
one location.

5 Create a new directory to store the CD-ROM files by entering

mkdir /cdrom ↵
6 Change to the cdrom directory by entering

cd /cdrom ↵

7 Retrieve the installation files from the /cdrom directory by entering

cp /cdrom/Solaris/install.bin ./install.bin ↵

8 Start the software installation process by entering

sh ./install.bin ↵
—continued—

ATTENTION
Do not uninstall Site Manager if it is already installed on your Sun 
Solaris 8 workstation.
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Procedure 2-3 (continued)
Installing Site Manager software files on a Sun Solaris 8 workstation

Step Action

9 Click Next to progress through the installation sequence. 

During the installation, you are prompted to

a. accept the license agreement

b. select the folder where you want to install the software (the default folder 
location is /opt/nortel/applications/sitemanager)

10 Click Done to acknowledge completion of the installation.

Note:  For information on running Site Manager, see the Preside Applications 
Platform Interface Login User Guide, 450-3101-012.

—end—
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Procedure 2-4
Installing Site Manager on an internal web server for web distribution

Use this procedure to install the Site Manager software files on your internal 
web server for PC, HP-UX 11, or Sun Solaris workstation web distribution.

Requirements
Before you start this procedure, you must set up your web server.

Step Action

Installing Site Manager software files on your internal web server for PC, HP-UX 11, or Sun Solaris 
workstation web distribution

1 Insert the Site Manager CD-ROM in the CD-ROM drive.

2 For PC web distribution, copy the PCWebDistribution folder in to a 
web-accessible directory on your server.

3 For HP-UX 11 or Sun Solaris workstation web distribution, copy the 
PresideWebDistribution folder in to a web-accessible directory on your 
server.

4 Ensure that the destination of the URL for the web distribution is to the 
install.htm file.

Accessing Site Manager software files on your internal web server from a PC

Note:  You do not need to install any other software. The Java virtual machine 
is included with the installation of the Site Manager software.

5 Ensure that you have a web browser application such as Netscape 
Communicator or Windows Internet Explorer open.

6 Locate the internal web server and web-accessible directory containing the 
Install.htm file.

Automated installation

7 Click on the Start Installer for Windows 98, NT... button.

8 During the installation you are prompted to

a. accept the license agreement

b. select the folder where you want to install the software

c. create a shortcut for accessing Site Manager

Note:  Do not use any of the following characters when specifying the 
installation folder or the shortcut location: < , > , / , \ , ? , * , : , |.
Using any of these characters prevents Site Manager from installing correctly 
(although no error message is displayed). If this occurs, you must re-install 
Site Manager.

—continued—
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Procedure 2-4 (continued)
Installing Site Manager on an internal web server for web distribution

Step Action

9 Click Done to acknowledge completion of the installation.

Manual installation

10 Click on the Download link.

11 From the Save Downloaded File dialog box, select the location where you 
want to save the file.

12 Click Save.

13 Double click on Install.exe.

14 During the installation you are prompted to

a. accept the license agreement

b. select the folder where you want to install the software

c. create a shortcut for accessing Site Manager

Note:  Do not use any of the following characters when specifying the 
installation folder or the shortcut location: < , > , / , \ , ? , * , : , |.
Using any of these characters prevents Site Manager from installing correctly 
(although no error message is displayed). If this occurs, you must re-install 
Site Manager.

15 Click Done to acknowledge completion of the installation.

16 You have completed this procedure.

Accessing Site Manager software files on your internal web server from an HP-UX 11 or Sun 
Solaris workstation

17 Ensure that you have a web browser application such as Netscape 
Communicator or Windows Explorer open.

18 Locate the internal web server and web-accessible directory containing the 
Install.htm file.

19 Click on the Download link to save the installer.

20 Log in to the workstation as root.

21 Copy the Install.bin file in the / directory.

a. Enter /.

b. Enter sh ./install.bin.

22 Click Next to progress through the installation sequence.

During the installation, you are prompted to

a. accept the license agreement

b. select the folder where you want to install the software (the default folder 
location is /opt/nortel/applications/sitemanager)

23 Click Done to acknowledge completion of the installation.

—end—
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Procedure 2-5
Recording the CD-ROM device name

Use this procedure to find and record the device name of the CD-ROM drive.

Step Action

1 Log in to the workstation as the root user by entering the root user ID and 
password in the login dialog box.

2 Open a console window.

3 Scan the system hardware for devices by entering

ioscan -fun

The system displays a list of system devices and a description of each device.

4 Locate the CD-ROM drive description in the list. The second line of the 
description contains the device name contained in the /dev/dsk file. For 
example /dev/dsk/c1t2d0.

5 Record the device name.

—end—
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Procedure 2-6
Uninstalling Site Manager from a PC

Use this procedure to uninstall Site Manager from a personal computer (PC).

Note:  This procedure provides instructions for uninstalling Site Manager 
using the Uninstall option in the Preside Site Manager program group. You 
can also uninstall Site Manager using Add/Remove Programs in the 
Windows Control Panel.

Requirements
Before you uninstall the software, you must:

• close the Site Manager application

• copy the files you want to keep from the Site Manager folder before they 
are deleted during the uninstall procedure

Step Action

1 Click Start on the Windows task bar, then select: Programs, <SiteManager>, 
Uninstall_PresideSiteManager.

2 In the Preside Site Manager Uninstall wizard, click Uninstall.

3 When the uninstallation is complete, click Done to close the Preside Site 
Manager Uninstall wizard.

Note:  Some folders and files cannot be removed during the uninstallation (for 
example, the LOGS folder is not removed). You can delete such folders and 
files manually.

—end—

where

<SiteManager> is the folder where you installed Site 
Manager. If you kept the default settings 
during the installation, the folder is 
“PresideSiteManager”.
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Procedure 2-7
Uninstalling Site Manager from an HP-UX 11 or from a Sun Solaris 8 
workstation

Use this procedure to uninstall Site Manager from an HP-UX 11 or from a Sun 
Solaris 8 workstation.

Requirements
Before you uninstall the software, you must:

• close the Site Manager application

• be authorized to log in to the workstation as the UNIX root user

• copy files you must keep that are resident in the Site Manager directory

Step Action

Note:  This procedure removes the UninstallerData folder you are currently 
in.

1 Log in to the workstation as the root user by entering the root userID and the 
password in the login dialog box.

2 Open a console window.

3 Change to the applications directory by entering

cd /opt/nortel/applications↵
4

Remove the software directory by entering

rm -r sitemanager↵
—end—

CAUTION
Removing the software directory
You must enter the complete command (as shown 
below) to remove the Site Manager directory. If you do 
not enter the complete command, you might remove 
other directories and all subdirectories.
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3-1

Site Manager overview 3-

Site Manager is a nodal management tool that you can use to operate, 
administer, maintain, and provision network elements. You can also use Site 
Manager to provision data parameters of Packet Edge circuit packs.

Operations that you can perform using the Site Manager user interface include:

• monitor alarms and alarm history

• retrieve a historical listing of performance statistics for specific network 
elements

• provision performance thresholds according to your performance 
management parameters

• provision equipment and facilities

• control protection status

• provision nodal and end-to-end connections within a span of control

• visualize remote equipment using shelf level graphics

Note 1:  For specific information on how to use Site Manager for a 
particular product, refer to the documentation for that product. Nortel 
Networks technical publications (NTPs) are available online and in print 
form.

Note 2:  For information on Site Manager online help, see Online help on 
page 3-11.

xxx-yyyy-zzz
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Main window
When you log in to Site Manager, the main window opens. See Main window 
layout on page 3-3. You can use the main window to

• connect to or disconnect from the network

• log in to, log out of, and select network elements

• log in to, log out of, and select Packet Edge circuit packs (OPTera Packet 
Edge system)

• initiate applications

The status bar in the main window reflects the state of the network connection. 
See Status message area on page 3-10. 

The main window contains the following components.

• Navigation area on page 3-4

• Alarm banner on page 3-7

• View/edit area on page 3-9

• Menu bar on page 3-9

• Status message area on page 3-10
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Main window layout
EX1476p.tif

Note:  The information in the main window varies according to product.



3-4   Site Manager overview

Site Manager 6.0   NTNM35FA   Standard   Rel 6.0   Iss 1   Nov 2003

Navigation area
Use the navigation area to view or edit details for any of the following:

• network element (OC-48 Lite Multiplexer or OPTera Metro 3000 series)

• network processor (OPTera Metro 3000 series)

• Packet Edge circuit pack, Packet Edge ring, or the Packet Edge network 
(OPTera Packet Edge system)

You must connect to a network element, network processor, or Packet Edge 
circuit pack to populate the navigation area with data.

The navigation area also displays alarm notification. 

For more information about the navigation area, see:

• Navigation area details for the OPTera Metro 3000 series and the 
OC-48 Lite Multiplexer on page 3-4

• Navigation area details for the OPTera Packet Edge system on page 3-5

• Alarm notification on page 3-6

Navigation area details for the OPTera Metro 3000 series and the 
OC-48 Lite Multiplexer

Note 1:  For Nortel Networks OPTera Metro 3000 series, a span of control 
is a subnetwork of network elements under the control of a network 
processor. For OC-48 Lite Multiplexer networks, a span of control includes 
only one OC-48 Lite Multiplexer network element.

Note 2:  The OC-48 Lite Multiplexer product does not have a network 
processor. References to the network processor apply to the OPTera 
Metro 3000 product. 

A network element is represented in the navigation area by its name/identifier 
(ID). 

When you select an item in the navigation area, its name/ID is highlighted. 
When you log in to a network element, a black outline appears around its 
name/ID. 

For the OPTera Metro 3000 series, network elements can appear in the 
navigation area as individual entries, or as part of a network processor span of 
control. If you log directly in to a network element, the navigation area 
displays the network element entry.
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Connecting to an OPTera Metro 3000 series network processor
When you connect to a network processor, the navigation area displays the 
network processor entry and the network elements in the associated span of 
control. (The navigation area refreshes with the new network processor data if 
there was a previous connection.) You can connect to only one network 
processor at a time.

The network elements within a network processor span of control are 
represented in the navigation area as items branching from the network 
processor. This is the navigation tree. 

Once you connect to the network processor, you can select and log in to 
multiple network elements simultaneously. See Selecting multiple network 
elements (OPTera Metro 3000 series) on page 3-17.

When you display a network processor span of control in the navigation area, 
you must log in to each network element and select it before you can view or 
edit the network element details. Select a network element from the navigation 
area to enable the associated menus and commands.

Navigation area details for the OPTera Packet Edge system
The navigation area displays the Packet Edge network, all rings in the network, 
and each circuit pack that is part of a ring. Circuit packs are identified by their 
system names if the system name is unique; otherwise, circuit packs are 
identified by their CPU port IP address.

Note:  For data management of a Packet Edge circuit pack through Site 
Manager, you log in directly to the circuit pack using your SNMP 
read/write/all community string. For details, refer to the OPTera Packet 
Edge System User Guide for OPTera Metro 3000 series, (NTN465YG). 
For SONET management of a Packet Edge circuit pack through Site 
Manager, you log in to the network processor whose span of control 
includes the network element that contains the Packet Edge circuit pack. 
For details, refer to Security and Administration (323-1051-302 for 
OPTera Metro 3300/3400 or 323-1059-302 for OPTera Metro 3500).
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Alarm notification
The navigation area displays alarm notification for individual network 
elements, for a network processor span of control, or for a Packet Edge 
network. The alarm notification appears next to the network processor, 
network element, or Packet Edge circuit pack affected by the alarm. The alarm 
notification includes an alarm label and color highlighting.

Alarm label
The components of the alarm label can include the following items.

Color highlights
The alarm label can have one of the following color highlights:

• red for critical and major alarms

• orange for minor alarms

• yellow for warnings

Note:  The alarm label does not indicate a severity level of 
threshold-crossing alerts.

Use the Clear Highlighting button in the Alarm banner to remove the color 
highlights for active alarms. The Clear Highlighting button is the button with 
the red and white overlapping squares. When the alarm count changes, the 
alarm label shows color highlights for the alarm with the highest severity level.

The alarm notification in the navigation area appears with the information 
displayed in the alarm banner. For more information on the alarm banner, see 
Alarm banner on page 3-7.

number Indicates the number of alarms of the highest severity that are 
active on the network element.

C One or more alarms with a critical severity are active on the 
network element.

M One or more alarms with a major severity, but no alarms with 
a critical severity, are active on the network element.

m One or more alarms with a minor severity, but no alarms with 
a critical or major severity, are active on the network element.

W One or more warnings are active on the network element.

* (asterisk) One or more threshold-crossing alerts are active on the 
network element.

+ (plus sign) One or more alarms with a lower severity are also active on the 
network element.
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Alarm banner
The alarm banner displays the total number of active alarms for all network 
elements or for the Packet Edge network that you are connected to. You must 
be logged in to activate the alarm banner.

The alarm banner displays counts of alarms with critical, major, and minor 
severities, and warnings. The alarm banner displays an asterisk to indicate 
threshold-crossing alerts. The alarm counts represent the total of new, active, 
and acknowledged alarms. The alarm counts update as alarms are raised or 
cleared.

The alarm banner displays color highlights to notify you of changes to the 
alarm counts. When the alarm count changes, the alarm banner shows color 
highlights for the alarm with the highest severity level. The color highlights do 
not appear for changes in the alarm count caused by user connections. For 
more information on the color highlights, see Alarm severity levels on page 
3-7.

If Site Manager cannot communicate with a network element or with a Packet 
Edge circuit pack, the right side of the alarm banner displays a question mark 
(?).

To see the total alarm counts for individual network elements, for a network 
processor span of control, or for a Packet Edge network that you are logged in 
to, see Alarm notification on page 3-6.

Alarm severity levels
The alarm banner displays separate alarm count fields for alarms with critical, 
major, and minor severities; warnings; and threshold-crossing alerts.

Alarm count fields
The alarm count fields are as follows: 

C Displays the number of alarms with a critical severity that are 
active on all network elements or Packet Edge circuit packs that 
you are logged in to.

M Displays the number of alarms with a major severity that are active 
on all network elements or Packet Edge circuit packs that you are 
logged in to.

m Displays the number of alarms with a minor severity that are active 
on all network elements or Packet Edge circuit packs that you are 
logged in to.

W Displays the number of warnings that are active on all network 
elements or Packet Edge circuit packs that you are logged in to.
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The alarm count indications are as follows:

Color highlights
For critical, major, and minor alarms and warnings, the alarm banner displays 
a highlight color to notify you of the alarm with the highest severity. The color 
highlight appears as a background color in the alarm count field.

The alarm count field can have one of the following color highlights:

• red for critical and major alarms

• orange for minor alarms

• yellow for warnings

Note:  The alarm banner does not indicate a severity level of 
threshold-crossing alerts.

Use the Clear Highlighting button in the Alarm banner to remove the color 
highlights for active alarms. The Clear Highlighting button is the button with 
the red and white overlapping squares. When the alarm count changes, the 
alarm label shows color highlights for the alarm with the highest severity level.

Note:  The alarm count field does not show color highlights if the cause of 
changes to the alarm count are due to Site Manager user connections to 
network elements.

number In the C, M, m, and W alarm count fields, indicates the number of 
alarms of that severity, or warnings that are active on all network 
elements or Packet Edge circuit packs that you are logged in to.

* In the alarm count field, indicates that one or more 
threshold-crossing alerts are active on one or more network 
elements that you are logged in to. (Not applicable to the OPTera 
Packet Edge system.)

- In the alarm count field, indicates that no alarms of that severity, 
warnings, or threshold-crossing alerts are active on all network 
elements or Packet Edge circuit packs that you are logged in to.
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View/edit area
The view/edit area appears on the right side of the Site Manager main window. 
The view/edit area allows you to view or edit information for any of the 
following:

• network element (OC-48 Lite Multiplexer or OPTera Metro 3000 series)

• network processor (OPTera Metro 3000 series)

• Packet Edge circuit pack, Packet Edge ring, or the Packet Edge network 
(OPTera Packet Edge system)

When you log in and select an item in the navigation area, the view/edit area 
displays the related information. The contents of the view/edit area vary with 
the selected product and the selected command from the menus. When you log 
in to Site Manager and select a network element, network processor, or Packet 
Edge circuit pack, the Node Information window is the default display.

Menu bar
The menu bar is at the top of the Site Manager main window. You must log in 
to and select an item from the navigation area to enable the associated menus 
and commands.

The menu bar contains the following drop-down menus:

• File

• Edit

• Faults

• Configuration

• Performance

• Security

• Protection (Not applicable for the OPTera Packet Edge system)

• Window

• Help

The availability and contents of the drop-down menus change to reflect the 
available applications for the item selected in the navigation area. Commands 
that are not available are grayed out. Some commands are restricted by the 
security level of the user ID you use to log in to Site Manager.

Note:  For information on the commands available in the menu bar, refer 
to the product documentation or online help.
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Keyboard shortcuts
You can use the keyboard to access the menu options and associated 
commands. The key combination for menu access is shown in parentheses 
after the menu title. The key for a command is the underlined letter in the 
command list. Keyboard shortcuts appear on the menu next to the command.

Status message area
The status message area is a single-line text field at the bottom of the main 
window that displays status messages for Site Manager. 

The connection status is displayed on the right side of the status message area. 
The information displayed in the “Connected to” message depends on the 
connection type.

• network connection to a network element:
Connected to: <IP address>, <port> 

• direct connection with a serial cable to a network element:
Connected to: <port_name>

• modem connection to a network element:
Connected to: <telephone#>

Site Manager does not maintain a history of status messages.

Customizing the display
You can modify the layout of the Site Manager display. Refer to the following 
procedures:

• Resizing windows on page 3-18

• Resizing table columns on page 3-19

• Sorting table columns on page 3-20

• Sorting table rows on page 3-21

• Displaying multiple windows on page 3-24
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Online help
Site Manager uses Sun Microsystems JavaHelp to provide procedures and 
context-sensitive information on windows and dialog boxes.

The online help has a toolbar and two areas (see Online help on page 3-12).

For more information on the online help, see

• Online help terminology on page 3-13

• Displaying online help on page 3-26

• Navigating through online help on page 3-27

• Printing an online help topic on page 3-29

Toolbar Contains the Previous, Next, and Print buttons. 

Previous button Click to retrace help topics in reverse 
order of the original selections, starting 
from the current help display.

Next button Click to retrace help topic selections in 
the same order as the original 
selections, starting from the current 
help display. The Next button is active 
only if you used the Previous button 
earlier during a session.

Print button Click to print the help topic text.

Content area Displays help topic text.

Navigation area Select a tab to switch between the table of contents, index, 
and full text search displays.

Table of Contents Select the left tab to see the table of 
contents of the help topics. You can 
expand and collapse the help topics.

Index Select the middle tab to see the index 
of help topics.

Full text search Select the right tab to search for a 
specific word or part of a word 
contained in the help topic.
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Figure 3-1
Online help

EX1477p.tif
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Online help terminology
The Site Manager online help uses the following terms to describe the 
graphical user interface components:

Dialog box A dialog box allows you to adjust operating variables. 
It appears in a window separate from the main screen. 
A dialog box does not contain menus. You cannot 
change the size of a dialog box. 

Drop-down list A drop-down list is a list that appears when you click 
the arrow button on the right side of a field. 

Drop-down menu A drop-down menu is a menu of commands that you 
can select by clicking on the menu name on the menu 
bar.

Links Links (blue, underlined or bold text) take you to 
another place in the Help. Underlined text links to 
another topic that appears in the content area. Bold text 
links to another topic in a separate secondary or pop-up 
window.

Pop-up menu A pop-up menu is a menu that appears when you 
right-click on a window or a dialog box.

Scroll bar A scroll bar appears at the right or bottom edge of a 
dialog box when the contents are not completely 
visible. Each scroll bar contains two scroll arrows and 
a scroll box. Use the scroll arrows and the scroll box to 
scroll through the contents of the dialog box or area.

Window A window appears in the view/edit area of Site 
Manager. It displays information related to the 
command selected from a menu. The Node Information 
window appears by default when you log in. 
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Procedure 3-1
Starting Site Manager

Use this procedure to start a Site Manager session on a PC, HPUX-11, or Sun 
Solaris workstation.

Note 1:  For information on starting Site Manager from a Nortel Networks 
Preside workstation, see the Preside Applications Platform Interface Login 
User Guide, 450-3101-012, or the Preside online information.

Note 2:  For information on logging in, consult the following documents 
depending on the product:

— for OPTera Metro 3000 series, see Nortel Networks OPTera Metro 
3500 Multiservice Platform, Security and Administration, 
323-1059-302 or the Nortel Networks OPTera Metro 3300/3400 
Multiservice Platform, Security and Administration, 323-1051-302.

— for an OPTera Packet Edge system, see Nortel Networks OPTera 
Packet Edge System User Guide for OPTera Metro 3000 series, 
NTN465YG.

— for OC-48 Lite Multiplexer, see Nortel Networks OC-48 Lite 
Multiplexer Preside Site Manager User Guide, NTLS65BB.

Requirements
Before you begin this procedure, ensure that Site Manager is installed on the 
PC, HPUX-11, or Sun Solaris workstation. Refer to Chapter 2, Site Manager 
installation for more information on installing Site Manager.

Step Action

1

Starting Site Manager on a PC

2 Click the Start button on the Windows task bar, then select: Programs, 
<SiteManager>, PresideSiteManager. 

Site Manager opens. The Login dialog box is displayed.

You have completed this procedure.

—continued—

If you installed Site Manager on a Then go to

PC step 2

HPUX-11 or Sun Solaris workstation step 3

where

<SiteManager> is the folder where you installed Site Manager. If you 
kept the default settings during the installation, the 
folder is “PresideSiteManager”.
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Procedure 3-1 (continued)
Starting Site Manager

Step Action

Starting Site Manager on an HPUX-11 or Sun Solaris workstation

3 Change to the directory where Site Manager is installed by entering

cd <directory> ↵

4 Start Site Manager by entering

sh SiteManager ↵
Site Manager opens. The Login dialog box is displayed.

You have completed this procedure.

—end—

where

<directory> is the directory where you installed Site Manager. If you 
kept the default settings during the installation, the 
directory is “/opt/nortel/applications/sitemanager”.
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Procedure 3-2
Closing Site Manager

Use this procedure to close a Site Manager session. 

Step Action

1 Select Exit from the File drop-down menu.

2 Click OK in the confirmation dialog box.

—end—
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Procedure 3-3
Selecting multiple network elements (OPTera Metro 3000 series)

Use this procedure to select multiple network elements.

You can perform the following actions simultaneously on selected network 
elements.

• autologin

• login as

• logout

For more information on login and logout procedures, see OPTera Metro 
3300/3400 Multiservice Platform Security and Administration, 323-1051-302 
or OPTera Metro 3500 Multiservice Platform Security and Administration, 
323-1059-302.

Step Action

1 Ensure that you are logged in to the network processor. See:

• OPTera Metro 3300/3400 Multiservice Platform Security and 
Administration, 323-1051-302, or 

• OPTera Metro 3500 Multiservice Platform Security and Administration, 
323-1059-302

2

Selecting all network elements

3 Press Ctrl+A.

You have completed this procedure.

Selecting multiple network elements

4 Click on a network element in the navigation area to select it.

5 Press and hold the Ctrl key.

6 Click on each additional network element you want to select.

7 Release the Ctrl key.

You have completed this procedure.

—end—

If you want to select Then go to

all network elements in the navigation tree step 3

multiple (but not all) network elements in the navigation tree step 4
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Procedure 3-4
Resizing windows

Use this procedure to change the size of the Site Manager window or 
navigation area.

Step Action

1 Hold the cursor over the border of the window or area you want to resize.

2 When the cursor changes to a double-ended arrow, click and hold the left 
mouse button and drag the border until the window or area is the required 
size.

3 Release the left mouse button.

Note:  The navigation area and window size return to the default size when 
you exit Site Manager.

—end—

If you want to modify Then hold the cursor over the

the width right or left border

the height top or bottom border

both the width and the height 
simultaneously
(applicable to windows only)

window corner
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Procedure 3-5
Resizing table columns

Use this procedure to change the width of a table column in Site Manager.

Step Action

1 Place the cursor in the table heading, over the right margin of the column you 
want to resize.

2 When the cursor changes to a double-ended horizontal arrow icon (<—>), 
click and hold the left mouse button while you drag the border of the column 
to the required column width.

3 Release the left mouse button.

Note:  The table column width returns to the default width when you log out 
of the network element or exit from Site Manager.

—end—
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Procedure 3-6
Sorting table columns

Use this procedure to change the order of columns in a table in Site Manager.

Step Action

1 Select the column that you want to move by clicking and holding the left 
mouse button on the column heading.

2 Drag the column to the new location.

3 Release the left mouse button.

Note:  The order of columns in the table returns to the default display when 
you log out of the network element of exit Site Manager.

—end—
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Procedure 3-7
Sorting table rows

Use this procedure to sort the rows in a table in ascending or descending 
alphanumerical order according to the content of one column.

Step Action

1 To sort the rows in a table, click on the column heading. The column heading 
that controls the sorting order for the table appears in a bold typeface.

Note 1:  You cannot sort the table rows in all windows.

Note 2:  All columns are sorted alphanumerically except the Date and Time 
columns. Date and Time columns are sorted by date and then time.

Note 3:  The order of rows in the table returns to the default display order after 
you close the window.

2 To sort the rows in the opposite order, pause, then click again on the same 
column heading.

Note:  A double-click on a column heading has the same result as a 
single-click.

—end—
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Procedure 3-8
Copying table data

Use this procedure to copy table data. You can then paste the table data into 
another application, such as a text editor.

Step Action

1 Display the window that includes the table.

2 Select the row(s) in the table:

Note:  Selecting groups of rows is supported for some tables only.

—end—

If you want to Then 

copy a single row of the table click on the row, then select Copy from the 
Edit drop-down menu, or press Ctrl+C

copy the entire table click on a row, then select Copy Table from 
the Edit drop-down menu, or press Ctrl+T

select a group of 
(consecutive) rows

click on the first row in the selection, press 
and hold the Shift key, then click on the last 
row in the selection

select a group of 
nonconsecutive rows

click on the first row in the selection, press 
and hold the Ctrl key, then click the 
remaining rows in the selection
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Procedure 3-9
Printing or saving tables

Use this procedure to print or save a table from Site Manager. Use this 
procedure if you want to print or save the complete table. If the window 
includes more than one table, all tables are printed or saved.

Note:  If you want to print or save specific rows of a table, complete the 
procedure Copying table data on page 3-22, paste the contents into another 
application (such as a text editor), and then print or save the data from that 
application.

Step Action

1 Display the window or dialog box that includes the table.

2

Printing a table

3 Print the table as follows:

• If the table appears in a window, select Print from the File menu, or press 
Ctrl-p.

• If the table appears in a dialog box, press Ctrl-p.

4 In the Print dialog box, select a printer and the printing preferences.

5 Click OK.

Saving a table

6 Save the table as follows:

• If the table appears in a window, select Save As from the File menu, or 
press Ctrl-s.

• If the table appears in a dialog box, press Ctrl-s.

7 In the Save As dialog box, select the drive and folder where you want to save 
the file.

8 Type the file name in the File name field. 

9 Click Save.

The file is saved using the comma-delimited file format.

—end—

If you want to Then go to

print a table step 3

save a table step 6
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Procedure 3-10
Displaying multiple windows

Use this procedure to open the Shelf Level View or the Active Alarms in a 
window separate from the main screen.

Step Action

1

Displaying the Shelf Level View in a separate window

Note:  The Shelf Level View application is not applicable to an OPTera Packet 
Edge system.

2 Select Shelf Level View from the Configuration drop-down menu to display 
the Shelf Level View window.

3 Do one of the following:

• Select Open In New Window from the File drop-down menu.

• Right-click the Shelf Level View window title bar, and select Open In New 
Window from the pop-up menu. 

The Shelf Level View window appears in a window separate from the main 
screen. The main screen displays the Node Information window. Both 
windows function independently.

Displaying the Active Alarms in a separate window

4 Select Active Alarms from the Faults drop-down menu to display the Active 
Alarms window. 

5 Do one of the following:

• Select Open In New Window from the File drop-down menu.

• Right-click the Active Alarms window title bar, and select Open In New 
Window from the pop-up menu. 

The Active Alarms window appears in a window separate from the main 
screen. The main screen displays the Node Information window. Both 
windows function independently.

Note:  Use the Window drop-down menu on any open window to toggle 
between the windows.

—end—

If you want to display the Then go to

Shelf Level View in a separate window step 2

Active Alarms in a separate window step 4
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Procedure 3-11
Editing Site Manager preferences

Use this procedure to set the following preferences for Site Manager:

• open either the Login dialog box or Login Manager window when you start 
Site Manager

• set the number of Host Name/Address or Login NE entries in the recent 
history drop-down list for these fields in the Login dialog box

• change the default directory from the current working directory

Step Action

1 Select Preferences from the Edit drop-down menu to open the Edit 
Preferences dialog box.

Setting the login method

2 Select the Login tab.

3 Under Startup, select the Login Dialog or Login Profile Manager radio button.

Setting the number of Host Name/Address or Login NE entries in the recent history drop-down list

4 Select the Login tab.

5 Under Login Dialog, type the required number of entries (between 1 and 100) 
in the Host Name/Address list or Login NE list.

Changing the default directory

6 Select the Default Directory tab.

7 Click Choose.

8 Search for and select the directory to use for the default directory according 
to the documentation for your operating system.

9 Click Select.

Closing the Edit Preferences dialog box

10 Click OK.

—end—
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Procedure 3-12
Displaying online help

Use this procedure to display online help for Site Manager.

Step Action

1 Display context-sensitive help by:

• selecting Current Window F1 from the Help drop-down menu

• clicking the Help button, if available, on the associated dialog box

• pressing F1 (on PC workstations)

Note:  F1 help is not available in the Terminal dialog box.

—end—
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Procedure 3-13
Navigating through online help

Use this procedure to navigate through online help.

You can navigate the Site Manager online help through the Table of contents, 
the Index, or the Full-text search options from the navigation area. The Table 
of contents and Index are organized as a list of topics that you can expand and 
collapse. The full-text search allows you to search for a word or part of a word 
in the online help; the Site Manager help system will display all entries that 
match the search string.

Step Action

1

Using the table of contents

2 Select the Table of contents tab in the navigation area. The Table of contents 
tab is the left tab.

3 Expand the help topic entry in the navigation area by selecting the expand 
icon.

4 Select the help topic entry.

The Help browser content area displays the selected information.

Using the index

5 Select the Index tab in the navigation area. The Index tab is the middle tab.

6 Enter a term in the Find field.

7 Press Enter.

Note:  The index Find field is case-sensitive. Each time you press Enter, the 
find term is highlighted in the index. The matching topic is displayed in the 
content area.

Using the full-text search

8 Select the Search tab in the navigation area. The Search tab is the right tab.

9 Enter a term in the Find field.

—continued—

If you want to use the Then go to

table of contents step 2

index step 5

full-text search step 8
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Procedure 3-13 (continued)
Navigating through online help

Step Action

10 Press Enter.

The navigation area displays topics that contain a partial or full match of the 
search term. Topics are listed in descending order of relevance. The order of 
the topics in the list is determined by:

• the type of match; for example, if the topic contains a partial or full match

• the number of times the search term occurs in the topic

A topic that contains two exact matches with the search term may appear 
higher in the list than a topic that contains five partial matches. A circle and a 
number appear beside each topic in the list. The circle indicates the relevance 
of the topic and the number indicates the number of times the full or partial 
search term appears within the topic.

—end—
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Procedure 3-14
Printing an online help topic

Use this procedure to print an online help topic.

Step Action

1 Display the Help window. For instructions, see Displaying online help on page 
3-26.

2 Click the Print icon on the toolbar of the Help window.

—end—
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4-1

Ordering information 4-

This chapter describes the software and documentation components for Site 
Manager Release 6.0. This chapter also identifies the Nortel Networks product 
engineering codes (PECs) required to order the components.

To order Site Manager Release 6.0, contact your local Nortel Networks 
support organization.

Software
Table 4-1 identifies the PEC for ordering software components for Site 
Manager Release 6.0. 

Certificate
Table 4-2 identifies the PECs for ordering a right-to-use (RTU) certificate for 
Site Manager Release 6.0. You need to order an RTU for each network 
element.

Table 4-1
PEC for Site Manager software components

Software component PEC

Site Manager Release 6.0 Application Kit includes:

• Site Manager Release 6.0 Software

• Site Manager Release 6.0 Planning and Installation Guide (electronic version on 
CD)

NTNM14FA

Table 4-2
PECs for RTU certificates

RTU description PEC

Site Manager Release 6.0 Upgrade RTU NTNM79FA

Site Manager Release 6.0 OC-48 Lite Multiplexer RTU NTNM79FB

Site Manager Release 6.0 OPTera Metro 3000 Series RTU NTNM79FC

xxx-yyyy-zzz
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Documentation
Table 4-3 identifies the PEC for ordering the printed version of this document.

Table 4-4 identifies the PECs for ordering documentation for products 
supported by Site Manager Release 6.0.

Table 4-3
PEC for Site Manager Release 6.0 Planning and Installation Guide

Software component PEC

Site Manager Release 6.0 Planning and Installation Guide NTNM35FA

Table 4-4
PECs for documentation 

Product Release Document(s)

OC-48 Lite Multiplexer 1.1 • Planning Guide, NTLS63AB

• Preside Site Manager User Guide, NTLS65BB

• Preside Site Manager Alarm Clearing Guide, NTLS65CB

OPTera Metro 3100 4.02 • OPTera Metro 3100 Multiservice Platform Planning Guide, 
NTRJ10AF

• OPTera Metro 3100 Multiservice Platform Ordering Guide, 
NTRJ11AE

OPTera Metro 3300/3400 
Multiservice Platform

9.1 OPTera Metro 3300/3400 Multiservice Platform Release 9.1 
Planning and Ordering Guide, NTRN11AK (see Note)

11.1 OPTera Metro 3300/3400 Multiservice Platform Release 11.1 
Planning and Ordering Guide, NTRN11AL (see Note)

OPTera Metro 3500 
Multiservice Platform

10.1 OPTera Metro 3500 Multiservice Platform Release 10.1 
Planning and Ordering Guide, NTRN10AK (see Note)

10.3 OPTera Metro 3500 Multiservice Platform Release 10.3 
Planning and Ordering Guide, NTRN13AL (see Note)

11.0 OPTera Metro 3500 Multiservice Platform Release 11.0 
Planning and Ordering Guide, NTRN10AL (see Note)

12.0 OPTera Metro 3500 Multiservice Platform Release 12.0 
Planning and Ordering Guide, NTRN10AM (see Note)

Note:  The Planning and Ordering Guide includes the complete list of PECs for documentation.
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